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Thank you for purchasing Jasc Media Center Plusä 3.10! Our newest release of Jasc Media Center Plus is packed with powerful new features and enhancements. Once you begin using the program, we think you will see just how easy it can be to organize and publish your own media files.





Please remember that this is a licensed version of Jasc Media Center Plus, and cannot be freely distributed. See the license agreement information included in this document for limits on copying this software and other important information.
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What’s New in Jasc Media Center Plus 3.10?


Changes to the user interface:


Updated menu and toolbar icons.


A “flat look” thumbnail graphical option, much like that of the PSP Browser, with an additional option to use the Windows color scheme in addition to the classic JMCP look.


Support for non-symmetrical thumbnails, specified and maintained individually for each album file.


Improved printing support with more efficient use of space, including tighter packing of images when no image-specific text is in use, and additional user control over the size of comment blocks.


Full-featured multiple file batch file format conversion.


Enhanced slideshow transition effects with better performance, optional random ordering, and direct transitions (i.e., from one image directly to the next, without intervening black screens) on non-paletted displays.


“Yes to All/No to All” options on dialogs for various file system operations throughout the program when multiple files are selected.


A number of enhancements to the MCML language used by Export to HTML templates, providing greater access to thumbnail information, easing template creation, and other improvements.


A significantly greater variety of templates for the Export to HTML feature. 


Media Center Plus now supports Adobe-compatible file format plug-ins.  This support may be configured on the new “Plug-ins” page of the File Format Preferences dialog.


Mediafile Information and Info Tips now report the resolution and planes data for image files more precisely.


When new files are saved (either as a result of the Mediafile Convert or Mediafile Rotate processes), invalid resolution data from the source file is no longer used.  Instead, a reasonable default resolution setting is applied in such cases.


When the Jasc Media Center Plus screen saver is running, the user will never be prompted for file open information for PCD, EPS or WMF files, regardless of the user’s selections for those options in the File Format Preferences dialog of Jasc Media Center Plus.


When the Jasc Media Center Plus screen saver runs, it will never update thumbnails or remove orphans in the specified album, regardless of the user’s selections for those options in the General Program Preferences dialog of Jasc Media Center Plus.


When a filename collision occurs during the renaming of a single file, the message box now shows the filename correctly.


Carriage returns embedded in album comments text will now be shown properly when the album is printed.


Several new commands and capabilities were added to the MCML language used by the Export to HTML feature.


A few minor bugs in the MCML language were fixed.


Any errors in an MCF file are now properly reported during the Export to HTML process.


The default setting for the source file copying/linking option in the Export to HTML dialog has been changed to Copy, rather than Link.


Additional templates for the Export to HTML function have been included.


An HTML statistics dialog box, including easy one-click review of pages immediately after export, has been added.





File Formats


TIFF


Files in the little-endian (Intel) byte order are now identified correctly


Fixed a problem reading poorly compressed LZW TIF files.


Fixed inability to open some multi-page TIFF files. 


Uncompressed TIFF images can now be written to a maximum width of 32,768 pixels. Previous versions encountered a problem when at a limit of 10,666 pixels wide.


BMP


Fixed reading OS2 version 2.x bitmaps.


Added supporting BMP files with negative heights.


WMF/EMF


Fixed Text size, formatting, and placement for WMF and EMF metafile input and output.


Plugged some memory leaks.


Faster reads and writes due to memory allocation changes.


Improved updates to File Read/Write progress bar.


Allowed for embedded bitmaps in metafiles to have negative values for Height and Width.


Better control of bitmap palettes in metafiles.


Fixed problems with single pixel (or no pixel) lines.


Fixed Arc functions.


Improved support of Multibyte character sets for metafiles.


Now allows reading in multiple embedded (raster) bitmaps in a metafile. Previous versions could only read in one embedded bitmap.


Fixed PolyDraw, AngleArc, and Path drawing functions for EMF metafiles.


Arc drawing direction is now programmable by metafile function.


Fixed potential problems with various Bezier drawing functions.


Improved error reporting if unable to allocate enough memory when loading a metafile.





Miscellaneous File Format Support Changes


PNG alpha channels are treated as transparency channels instead of alpha channels. (This change may or may not make it in to the final release of 3.10)


Thumbnails: Changed the JPEG compression factor for thumbnails from 15 to 5 to encode higher quality thumbnails. The JPEG compression factor for full-size composite images remains at 15.


Fixed problems importing vector data from some CDR9 files. 


Some CGM files open with white colors only (blank image).  Default for bad color values of lines was white.  CGM specs require that lines, edges, and fills (brushes) get set to black.  Black is now saved and being set as default for lines, edges, and brushes.





What's New in Jasc Media Center Plus 3.02?


We have added file format support for the Paint Shop Pro 7 to Media Center Plus 3.02.  For more detailed information about using this feature, please consult the Media Center Plus 3.02 help file.





What's New in Jasc Media Center Plus 3.0?


We have added several great new features and enhancements to Media Center Plus 3.0. A brief description of what we feel are the most significant changes is provided below. For more detailed information on using these features, please consult the Media Center Plus 3.0 help file.





24-bit thumbnail support, allowing better-looking thumbnails.


Advanced Find/Select tool, allowing you to specify more sophisticated search criteria to find and select thumbnails.


The Toolbar is now configurable, allowing you to customize the interface to your preference by adding, removing and sorting buttons.


An enhanced Copy/Cut/Paste tool for manipulating the clipboard contents from within Media Center Plus or other software.  Not only will it allow you to copy a single thumbnail to the clipboard, but you can copy multiple files to the clipboard.


Digital camera support for importing images from digital cameras.


TWAIN support for importing images from devices such as scanners.


Drag and Drop capabilities, which provide an essential tool for moving files between albums, rearranging thumbnails within an album, or moving and copying files to and from an album.


The Edit Using capabilities have been upgraded for Windows 95/98/NT, with the purpose of executing applications to edit a media file in a more consistent and efficient manner.


Export to HTML capabilities, allowing you to automatically generate one or more HTML web pages that display the contents of an album (or portions thereof) in a “gallery” style.


The progress bar has been modified to indicate the estimated remaining part of the process when creating a new album or adding files to an album.


The toolbar has been changed to the flat look. 


The Info Tips feature has been introduced, giving you an easy way to get information about individual thumbnails, without having to bring up a menu or a dialog.


The Keeping Albums Sorted feature provides users of version 3.0 with a method for albums to be continually kept in a sorted order, even when the album contents are being changed or added to, and without all of the intensive steps that are required with version 2.


An MDI (Multiple Document Interface) application has been introduced, allowing multiple albums to be open at the same time.


The Sort command has been moved from the AlbumFile menu to the Edit menu.


The New Album From Selection feature allows you to create a new album using the selected thumbnails from the current album.


The Print dialog box has been modified and enhanced, allowing you to customize the print settings in a much more specific way.


Media Center Plus has now the ability to print images at standard photo sizes or at custom sizes.


Right-click context menus have been introduced for your convenience, so you aren’t required to use the normal menus, which require more mouse clicks to access.


The Select All and Invert Selection features allow now you to have more control over the selection of thumbnails.


Thumbnails can now be saved at different sizes and bit depths to give you more control over the size of the album and over the appearance of the thumbnails on screen.


The new ToolTips feature on the toolbar allows you to see a description of a toolbar button every time the mouse cursor rests over it.


The Web Site/Page Location Links feature has been introduced for keeping track and sorting files by their Web Page Addresses. You can also link to the addresses via web browser to check the content of these files.


The file format support has been greatly enhanced by adding a considerable number of raster, vector, animation and audio file formats.


The new Send Files feature allows you to send media files within an album to someone via e-mail. 


The File Type Groups feature enables you to specify more than one file type when scanning directories for media elements to add to an album.


Icons have been added to the menu items. A preference item has been added to turn this option off.


A Window > Close All command has been added.


Color bars have been added for the current thumbnail (the one most recently clicked).  The default color is red, but it can be changed through the Preferences dialog box.


You can now rename multiple thumbnails at the same time, using the Batch feature in the Rename utility.


All spin controls now have a slider bar to help you reach a value in a faster way.


The Save As dialog box includes now a checkbox for updating title.


The following accelerators have been changed: Shift+C for Edit>Comments, Shift+K for Edit>Keywords, Shift+E for Mediafile>Edit Using(primary editor), and Enter for Mediafile>Play/View.


There is now only one Image scaling radio button in the Preferences dialog box, which works for both Play/View and Slideshow options.


You can now send your pictures to the Jasc StudioAvenue.com web site, so your friends can visit the site and view them.


You can now rotate thumbnails using the added “Rotate” command.


You can now use any of your albums as your Windows screen saver.





What's New in the Online Help?


The online help features a new navigation pane to the left of the topic information, which remains available at all times for easier navigation. It also provides access to the Table of Contents, Keyword Index, and Full Text Search.





Using and Reporting Issues with this product


System Recommendations


In order to install and use this product, you will need to have at least:


A PentiumÒ processor


CD-Rom drive


32MB RAM


25 MB free hard disk space


A display adapter and monitor capable of displaying 256 colors at 800 x 600 resolution


Windows 95/98/2000 or Windows NT 4.0





Please note: Microsoft Windows Media Player is required to use the Play/View or Slideshow features with MP3 and MPEG format files.  If this application is not installed on your system, please visit the Windows Media Player download page at “http://microsoft.com/windows/mediaplayer/download/default.asp”.  If you experience any problems with MP3 or MPEG playback, you should install the latest version of the player from this download page.





Although this software is designed to work under a wide variety of system configurations, we also recommend that you perform some basic system maintenance tasks in order to minimize the possibility of encountering problems arising from existing issues on your system. Such tasks include running Scandisk and the Disk Defragmenter (if applicable), obtaining and installing the latest patches and fixes for your operating system, removing unused files in your system temp directory, and updating drivers for your video card, printer and any other devices you want to use with Media Center Plus 3.0. More information on performing these tasks can be found in the Windows Help file or through your computer vendor.





How to Contact Us


There are several sources for contacting us:





Technical support for Media Center Plus can be obtained from:





Jasc Software, Inc.


PO Box 44997


Eden Prairie, MN 55344 USA


Voice:	(952) 930-9171


Fax:	(952) 930-9172


Internet:	mcpsup@jasc.com


Web:	http://www.jasc.com





Email (suggestions) - You can submit any suggestions for product enhancements to: jmcpideas@jasc.com. Please note that all suggestions will be considered for future development. The suggestions we've received over the past several years have resulted in this new version of Jasc Media Center Plus, and we hope you will continue to provide us with suggestions so that we can continue to develop software that serves your needs.





Media Center Plus now also provides direct support for many of the most popular digital cameras (listed below). A list of supported cameras is also available at this location: http://www.jasc.com/dcsdl.html. Please, forward your digital camera support requests to: camrequest@jasc.com.





Reporting Issues or Problems


If the problem appears to be related to the computer display or to a device such as a printer, digital camera, or scanner, please check with the manufacturer of the device or your computer vendor to see if driver and firmware upgrades are available. If upgrades are available, please obtain and install them and test for recurrence of the problem.





If you are using the latest drivers and are still encountering the problem, we encourage you to send it to the email address provided in item 1 of the How to Contact Us section above.





When reporting a problem, please provide the following information:





1.	Information on your system, including processor type, RAM, video card type and display settings, free disk space, and information on any peripheral devices, if applicable. This information can typically be found in the Windows Device Manager or under the properties of the device when highlighted in My Computer. See the Windows Help file for details on using Device Manager and My Computer.





2.	Which version of the software you are using. You can check this by selecting the About Jasc Media Center Plus command from the Help menu of the application. The version number is reported in the upper right of this dialog.





3.	The specific, unexpected result you encountered with the program. Did the program lock, become unstable, or display an error?  If the problem was not an error or instability, what result did you expect? Is this expectation confirmed by the description of the feature in the help file?





4.	The specific steps you took before you encountered the problem. What commands did you select, and which settings were used? If possible, try to reproduce the problem using the fewest number of steps before you send us the details to eliminate any unnecessary steps. It is far easier for us to take action on any issue that we can reproduce quickly, so this information is a big help to us.





Jasc Media Center Plus Upgrades, Pricing, and Product Availability


Information on upgrades, pricing, and product availability is available at http://www.jasc.com.





Digital Cameras


Please, visit our Jasc Software Digital Camera Support web page at "http://www.jasc.com/dcsdl.asp“ to obtain a complete list of supported digital cameras. If your camera is TWAIN-compliant and not directly supported though our direct drivers, you can still use the device with our programs using the standard TWAIN interface.
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